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1 Tixi Message Modem Features 
Die Tixi Message Modem AT Produktfamilie umfasst neuartige, intelligente Kommunikationsgeräte,  
die - ohne PC - mit einem einfachen Kommando Nachrichten versenden und empfangen können,  
je nach Tixi-Modem z.B. 

SMS im Festnetz und in das Mobilnetz 
Fax Senden von Texten und Daten als Fax 
E-Mail per Internet 
Express E-Mail 1) E-Mail ohne Internet, d.h. 

E-Mail direkt per Telefonleitung 

Das Tixi Super Modem AT/Tixi Message Modem AT ist im Modem Mode als "normales" AT-Modem nutzbar. 
Nähere Informationen darüber finden Sie im Handbuch "AT-Befehlssatz". 

Typ SMS Fax E-Mail Express Datenspeicher 
 mobil Festnetz   E-Mail Grund-

speicher 
erweiter- 
bar um 

Tixi Super Modems        
HSM 2) 
Tixi Super Modem AT V.90 • • •3) •3) • ca 30 kB -

Tixi Message Modems        

HMM 2) 
Tixi Message Modem AT V.90 • • • • • 2 MB 64 MB 

1) Mit dem Express-E-Mail Verfahren können E-Mails ohne Internet direkt per Telefonleitung an den 
Empfänger gesendet werden. Ein Internet-Provider ist für Express E-Mail nicht nötig. 

2)   Weitere Modelle sind für OEM-Kunden verfügbar. 
3)   Fax und E-Mail erst ab Seriennummer 016570 verfügbar 

 

Express E-Mail: Mit dem Express-E-Mail Verfahren können E-Mails ohne Internet direkt per Telefonleitung an 
den Empfänger gesendet werden. Ein Internet-Provider ist für Express E-Mail nicht nötig.  
Einzige Voraussetzung: Der Empfänger hat ein Tixi-kompatibles Modem. 

SMS mobil Alle Tixi AT Modems können SMS ins Mobilfunknetz senden. 
Die Mobilfunkbetreiber bieten dazu spezielle Gateways an. Der Empfang von SMS erfolgt über 
die Festnetz-SMSC der DTAG und AnnyWay. 

SMS im Festnetz ist ein spezieller Dienst der Deutschen Telekom, der es ermöglicht,  
im Festnetz SMS zu empfangen und zu senden. 

Datenspeicher: Der Grundspeicher (ca 30 kB) der Tixi Super Modems AT ist nicht stromausfallsicher (SRAM). 
Der Grundspeicher (2 MB) der Tixi Message Modems ist ein Flash-Memory und deshalb 
stromausfallsicher. 
Alle Speichererweiterungen sind Flash-Memory und halten die Daten auch bei Stromausfall. 
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2 Schnelleinstieg 

2.1 Hardware-Installation und Montage 
Die folgende Abbildung verdeutlicht, welches Kabel Sie an welche Buchse des Modems anschliessen müssen. 
Die Abbildung zeigt ein HMM Tixi Message Modem AT V.90, das sich in der Lage der Anschlüsse vom HSM 
Super Modem AT V.90 jedoch nicht unterscheidet. 

 

 

Verbinden Sie die mit Line 
gekennzeichnete RJ12-Buchse des 
Gerätes über ein Telefonkabel mit Ihrem 
Telefonanschluss. 

 

Schliessen Sie eine 
Spannungsversorgung von 10...30 VDC 
an die entsprechend beschriftete 
Schraubklemme an. 

 

Benutzen Sie ein serielles 1:1-Kabel, um 
das Gerät an eine serielle Schnittstelle 
des PC anzuschliessen 

 

 

Um das Tixi Super Modem AT oder das Tixi Message Modem AT an eine Steuerung 
mit RS232 Buchse anzuschließen, muss ein Nullmodem-Kabel (Stecker-Stecker) 
verwendet werden. Verwenden Sie einen "Blue Adapter" (blauer Adapter) und ein 
serielles 1:1-Kabel, um ein solches Nullmodem-Kabel zu erhalten. Der "Blue Adapter" 
ist wie folgt geschaltet: 

 

 

Montage: 

Zum Einbau montieren Sie das Gerät auf einer 35mm-Hutschiene, wie in der folgenden Abbildung gezeigt: 

 
 

Das Gerät darf nur in trockenen und sauberen Räumen eingesetzt werden.  
Schützen Sie das Gerät vor Feuchtigkeit, Spritzwasser, Hitzeeinwirkungen und direkter Sonnenbestrahlung. Das 
Gerät darf nicht in Umgebungen eingesetzt werden, in denen entzündliche Gase, Dämpfe oder Stäube oder 
leitfähige Stäube vorhanden sind. Setzen Sie das Gerät keinen starken Schocks und Vibrationen aus. 
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2.2 Bedeutung der LEDs 
LED Bedeutung 

Power Leuchtet , wenn das Tixi-Modem betriebsbereit ist und  
blinkt im Falle eines schweren Fehlers. 

Mail in Leuchtet, wenn das Tixi-Modem Signale verarbeitet oder wenn Nachrichten 
eingegangen und noch gespeichert sind. 

Line Blinkt, wenn eine Verbindung hergestellt wird und 
leuchtet, sobald die Verbindung steht. 

Mail out Leuchtet, solange sich zu versendende Nachrichten im Speicher befinden und blinkt 
während des Bootvorgangs. 

Modem Mode Leuchtet, sobald sich das Tixi Modem im Modem Mode befindet. 
 

 

2.3 Verbindung zum Telefonnetz 
Die Verbindung zum Telefonnetz wird mit dem gelieferten Telefonkabel über die mit "Line" beschriftete Buchse 
hergestellt.  

 

 

 

Das Tixi Alarm Modem verwendet die a/b-Leitungen. 

 
Damit Ihr Tixi Modem erreichbar wird, muss die Telefonnummer des verwendeten Anschlusses bekannt sein. 
Sollen SMS an einer Nebenstellenanlage empfangen werden, so muss diese das Feature "SMS im Festnetz" 
unterstützen. 

2.3.1 Test der Telefonnummer des Anschlusses  

Um zu überprüfen, welche Telefonnummer die Telefondose hat, an die das Tixi Modem angeschlossen werden 
soll, schliessen Sie zunächst ein einfaches Telefon (A) an diese Telefondose an. Wählen Sie nun von einem 
beliebigen anderen Telefon (B), z.B. einem Handy, die Nummer des Anschlusses (A). Klingelt das Telefon (A), 
ist die verwendete Nummer richtig. Anderenfalls können Sie die Rufnummer des Anschlusses A ermitteln, in 
dem Sie mit Telefon (A) die Nummer des Telefons (B) wählen. Falls Anschluß (A) die Rufnummernübertragung 
(CLIR) unterstützt, wird Telefon (B) nun klingeln und die Nummer (A) anzeigen.  
Wenn die Rufe in beide Richtungen erfolgreich durchgehen, können Sie das Tixi Modem anschliessen. Ihr Tixi 
Modem kann nun angerufen werden, Nachrichten empfangen und durch die übermittelte Rufnummer des 
Anrufers definierte Aktionen auslösen.  

2.3.2 Rufnummernerkennung CLIP  

Zum Auslösen von Aktionen im Tixi Modem müssen die eingehenden Rufnummern von Ihrem Telefonanschluss 
erkannt werden. Dieses erfolgt über die CLIP-Funktion zur Rufnummernerkennung, die Sie bei Ihrem 
Telefonanbieter beantragen und freischalten lassen können.  

2.3.3 Anschluß an eine Nebenstellenanlage 

Bei Anschluss des Tixi Modem an eine Nebenstellenanlage beachten Sie bei der Konfiguration des Gerätes die 
dabei ggf. zu beachtenden Amtsvorwahlen sowie die CLIP-Fähigkeit der Nebenstellenanlage. 
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2.4 COM1 – RS232 (Buchse)  
 

Die RS232-Schnittstelle COM1 (9-polige D-Sub-Buchse) ist bei 
allen Tixi  Modem Modellen vorhanden. Sie dient in erster Linie als 
Programmierschnittstelle zum Anschluss eines PCs. Dazu kann ein 
handelsübliches serielles Kabel 1:1 verwendet werden (nicht im 
Lieferumfang enthalten).  

Am Stecker des RS232-Kabels zum Modem darf kein Material 
überstehen, das die EInstecktiefe verringern und die 

Kontaktsicherheit beeinträchtigen könnte. 

1 DCD

RTS 7

DSR 6

CTS 8

RI 9

2 RXD

3 TXD

4 DTR

5 GND

COM1

 
 

 

2.5 Den Message Mode aktivieren 
Das Tixi-Modem befindet sich nach dem ersten Einschalten im Modem Mode.  
Dies ist an der rot leuchtenden Modem Mode LED erkennbar; in diesem Modus kann das Tixi-Modem als 
normales AT-Modem z.B. zum Internet-Surfen oder Faxen vom PC verwendet werden. Eine Übersicht der im 
Modem Mode nutzbaren Befehle finden Sie im Handbuch "AT-Befehlssatz". 

Damit das Tixi-Modem die Tixi Message-Kommandos erkennt,  
muss es in den Message Mode geschaltet werden: 
 
 

1. AT+T Mode = "MessageMode"   Dieses Kommando aktiviert den Message Mode. 
              Die Modem Mode LED verlischt.  

 AT+T Mode = "ModemMode"     Der Message Mode bleibt solange aktiv, bis mit diesem Befehl 
                         wieder der Modem Mode aktiviert wird. 
 

 
Zum Testen werden die folgenden Kommandos empfohlen: 

2. AT+T Echo="on" - Aktiviert die Anzeige der eingegebenen Kommandos am Bildschirm.  

3. AT+T Verbose="on" - Schaltet ausführliche Rückantworten ein,  
die mehr Aufschluß über die Aktionen des Modems geben als nur "OK" oder "Error". 

4. AT+T Time="JJJJ/MM/TT,hh:mm:ss,+0100" – Setzt die Uhrzeit im Tixi-Modem,  
die z.B. für die Zeit und das Datum in der Faxkopfzeile verwendet wird.  

Nun können die Message Modem-Befehle manuell mit dem Terminalprogramm oder mit TACO (siehe Kapitel 7) 
ausprobiert werden. Dann kann das Tixi-Modem an die Steuerung angeschlossen werden. 
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2.6 Test 1: Ein Fax versenden 
1. Setzen Sie zuerst die allgemeinen Parameter für alle Nachrichtentypen mit diesem Befehl: 

AT+T Send = "ALL; DialPrefix:nnn; ModemName:Name; ModemNumber:Number" 

Ersetzen Sie dabei die kursiv gedruckten Angaben durch die für Ihren Anschluss zutreffenden Werte: 

nnn Amtsvorwahl des Anschlusses (optional) 

Name Geben Sie hier einen Namen für Ihr Tixi-Modem an. 

Number Nummer des Telefonanschlusses, an dem das Tixi-Modem arbeitet, zB. 00493012345678 

 

2. Senden Sie die erste Nachricht mit dem Befehl:  

AT+T Send = "Fax; Dial: Rufnummer" 

Rufnummer  Nummer des Empfängers, inklusive Ortskennzahl (falls erforderlich). 
 

3.  Eingabe des Textes der Nachricht. 
Nachdem Sie den AT+T Send... Befehl an das Tixi-Modem gesendet haben, erscheint ein Prompt-
Zeichen (>), hinter dem Sie die Nachricht eingeben können. Umlaute sind nicht erlaubt. 
Die erste Zeile ist der Betreff, d.h. die Überschrift, die folgenden Zeilen sind der Text der Nachricht.  
Schliessen Sie jede Zeile mit ENTER ab.  
Zum Beenden der Eingabe und um den Versand zu starten, drücken Sie auf einer neuen Zeile die Tasten 
<STRG>+<Z>.  
Auf diese Weise wird der Text für alle anderen Nachrichtentypen eingegeben. 

Sollte auf die Befehlseingabe statt des Prompt-Zeichens ein "ERROR" folgen, war die Syntax des Befehls 
fehlerhaft. Prüfen Sie in diesem Fall alle Eingaben ab AT+T und wiederholen Sie diese korrekt. 

4. Beobachten Sie das Tixi AT Modem.  
Die Mail-Out LED leuchtet, sobald eine ausgehende Nachricht erzeugt wurde.  
Die grüne Line LED blinkt während des Verbindungsaufbaus und  
leuchtet dauerhaft, sobald die Verbindung hergestellt ist. Die Nachricht wird dann versandt. 
Diese LED verlischt, wenn die Verbindung getrennt ist (entspricht beim Telefon dem Auflegen des Hörers)  

5. Meldung:   Nach Abschluss der Übertragung gibt das Tixi AT Modem  
(z.B. im Terminalprogramm) eine Meldung über den Versand aus. 

2.7 Test 2: Eine Express-E-Mail versenden 
Um eine Express E-Mail Nachricht versenden und empfangen zu können, benötigen Sie einen Partner, der ein 
Tixi-kompatibles Modem betreibt – das ist genau wie beim Faxverfahren. 

Zum einmaligen Antwort-Test können Sie folgende Express E-Mail Adresse bei Tixi.Com benutzen: 
Tixi-Reply+49-30-40608-555 
 

1.  Der Befehl AT+T Send = "ALL..."  (s.o.) muss nur 1x am Anfang gesendet werden. 

2. Senden Sie die Express E-Mail-Nachricht mit dem Befehl:  

AT+T Send = "Express; Dial: Rufnummer; To: Empfänger; From: Absender" 

Rufnummer   Nummer des Empfängers, inklusive Ortskennzahl (falls erforderlich). 
Empfänger   Express-E-Mail Adresse des Empfängers   (z.B. Fritz+49-89-9876543) 
Absender    Ihre Express-E-Mail Adresse            (z.B. Hans+49-30-12345678) 

3.  Eingabe des Textes und Ablauf wie beim Fax (s.o.) 
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2.8 Test 3: Die empfangene Express E-Mail auslesen 
Warten Sie einen Moment, bis die Nachricht verschickt wurde. Das Tixi-Mail System im Hause der Firma  
Tixi.Com GmbH wird Ihre Nachricht empfangen und automatisch eine Antwort an die Absender-Adresse 
zurücksenden (Das dauert ca. 3-6 Minuten). So können Sie prüfen, ob Ihr Tixi-Modem korrekt angeschlossen 
und konfiguriert ist. 

Sobald das Tixi-Modem die Antwort empfangen hat - während des Empfangs leuchtet die grüne Line-LED - 
können Sie an der rot leuchtenden Mail-in LED erkennen, dass sich eine Nachricht im Speicher befindet. Um 
diese auszulesen, gehen Sie wie folgt vor: 

1. Senden Sie den List-Befehl: 

   AT+T List = "ALL"    zeigt eine Liste der gespeicherten Nachrichten an. 

Die Zeilen dieser Liste beginnen mit +T List= ID-Nummer...  
- merken Sie sich die Nummer hinter dem Gleichheitszeichen,  
denn diese ist die ID-Nummer der betreffenden Nachricht. 

2. Benutzen Sie den Read-Befehl, um diese Nachricht auszulesen: 

   AT+T Read = ID 

Ersetzen Sie ID durch die ID-Nummer der gewünschten Nachricht (Schritt 1).  
Die Nachricht wird daraufhin vom Tixi-Modem ausgegeben (z.B. an das Terminalprogramm). 

3. Wenn Sie die Nachricht nicht mehr benötigen, löschen Sie diese mit dem Delete-Befehl: 

   AT+T Delete=ID 

Ersetzen Sie ID durch die ID-Nummer der gewünschten Nachricht (Schritt 1).  
Dass die Nachricht aus dem Speicher des Tixi-Modems gelöscht wurde, erkennen Sie daran, dass die rote 
Mail-in LED nicht mehr leuchtet. Wenn sie doch noch leuchten sollte, befinden sich noch weitere 
Nachrichten im Speicher, die Sie mit LIST anzeigen lassen können. 

 

2.9 SMS senden 
Das Senden einer SMS ist ebenso einfach und wird in Kapitel 5.2.3 beschrieben.  
Es wird jedoch dringend empfohlen, zuvor das Kapitel 3 zu lesen, um insbesondere die weniger bekannten 
Möglichkeiten des Sendens und Empfangens von SMS im Telefon-Festnetz zu beachten. 

2.10 Schneller Einstieg mit TACO, der Tixi AT-Console 
Um Ihnen die Arbeitsweise der Tixi-Modems zu verdeutlichen, bietet Tixi.Com das Programm TACO, die Tixi 
AT-Console, an. Dieses Tool ermöglicht einen einfachen Einstieg in die Konfiguration und Bedienung des Tixi 
AT Modems, ohne dass Sie das Handbuch studieren müssen. Nähere Hinweise zur Installation und Bedienung 
von TACO finden Sie im Kapitel 7. 

2.11 Tixi-Modems als Modems für den PC 
Um das Tixi AT Modem unter Windows auch als "normales" Modem nutzen zu können, müssen Sie den 
Modemtreiber installieren. Die nötigen Schritte sind im Tixi AT Modem-Handbuch beschrieben, das Sie wie die 
Modemtreiber im Internet unter www.tixi.com finden. 
 
Es kann auch ein handelsüblicher Standard-Modemtreiber zum Einsatz kommen. 
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3 Senden und Empfangen von SMS 

3.1 Mobilfunk-SMS oder Festnetz-SMS ? 

Es gibt zwei Arten, SMS vom Festnetz1 zu 
versenden: 

• SMS an einen Mobilfunkempfänger (z.B. 
ein Handy oder GSM-Modem) 

• SMS an einen speziellen Empfänger im 
Telefon-Festnetz 

 

Der Empfang von SMS im Festnetz ist nur unter 
speziellen Bedingungen möglich (s. Kapitel 3.3.2): 

• Empfangsgerät mit der Funktion SMS-im-
Festnetz 
z.B. einige DECT-Telefone, einige TK-Anlagen, 
Tixi-Modems. 

• Anmeldung an einem Festnetz-SMS-Service-
Center (s.u.) 

3.2 SMS in das Mobilfunk-Netz senden 
Um eine SMS an einen Mobilfunk-Empfänger (wie Handy 
oder GSM-Modem) zu senden, muss das jeweilige Gateway 
angegeben werden: 

Deutschland: 
D1    0171-2521002 (analog),  0171-2521001 (ISDN) 
D2    0172-2278025 (analog),  0172-2278010 (ISDN) 
E-Plus  0177-1167 
 

nur in EINE Richtung:  Festnetz    Mobilnetz. 
Diese Gateways (SMSC) arbeiten 

Österreich: 
A1   0900-664914 (nur analog) 

Schweiz: 
NatelD 079-4998990  (UCP) 

Bei diesem Verfahren wird die SMS von einem Absende-Modem oder PC bei dem Gateway nur  
"abgegeben" und dann die Verbindung beendet.  
Eine Bestätigung, ob und wann die SMS beim Empfänger angekommen ist, gibt es nicht, denn das Gateway 
"weiß" nicht, wer die SMS abgegeben hat und kann den Absender nicht benachrichtigen. 
                                                      
1 Festnetz:  Analoges und ISDN-Telefonnetz 
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3.3 SMS im Festnetz empfangen und senden 
SMS im Festnetz wird bisher nur von der Deutschen 
Telekom und dem SMS-Provider Anny Way, über TK-
Leitungen der Deutschen Telekom angeboten.  

 
Verwenden Sie die Nummern dieser SMSC,  
um SMS im Festnetz zu senden und zu empfangen: 

Deutsche Telekom AG:   0193010 
AnnyWay:           09003266900 

Damit die SMS als Text-Nachricht ankommt, müssen Sender und Empfänger das gleiche SMSC verwenden. 
Andernfalls erfolgt eine Wandlung in eine Sprach-Nachricht. 

Beachten Sie, dass Sie für den Empfänger der Nachricht das richtige Adressformat angeben.  
Die Adresse besteht aus der Ortskennzahl, direkt gefolgt von der Telefonnummer.  
Beachten Sie, dass die Ortskennzahl mit führender Null angegeben werden muss. 

SMS im Festnetz ist ein relativ junges Leistungsmerkmal der Deutschen Telekom. Änderungen und 
Erweiterungen sind nicht ausgeschlossen. Aktuellste Informationen zum Thema finden Sie im Internet bei T-
Com oder bei AnnyWay unter http://www.sms-im-festnetz.de. 

Die volle Nutzung der SMS-Features der Tixi AT Modem Familie ist derzeit bei Anschlüssen möglich, die im 
Ortsnetz über die Deutsche Telekom AG vermittelt werden. 

Wenn Sie Ihre Telefonrechnung nicht von der Deutschen Telekom AG erhalten, dann fragen Sie bitte bei Ihrer 
Telefongesellschaft nach, welche Leistungsmerkmale Ihr Anschluss bzgl. SMS im Festnetz unterstützt. 

3.3.1 SMS empfangen im Festnetz 

Um SMS über das Festnetz zu empfangen, muss das Dienstmerkmal CLIP (die Übermittlung der Rufnummer für 
ein- und ausgehende Rufe) an Ihrem Telefonanschluss freigeschaltet sein und von einer ggf. 
zwischengeschalteten Telefonanlage unterstützt werden. Erkundigen Sie sich ggf. bei Ihrem Telefonanbieter 
oder TK-Anlagen-Hersteller. 

Wenn Ihr Anschluss oder Endgerät nicht korrekt für Festnetz-SMS eingerichtet ist, wird jede eingehende SMS 
vorgelesen.  

3.3.1.1 SMS über die Deutsche Telekom empfangen 
Damit SMS als Textnachricht übertragen und nicht vorgelesen werden, muss der betreffende Anschluss dafür 
freigeschaltet werden. Dazu müssen Sie lediglich eine SMS mit dem Text ANMELD an die Rufnummer 8888 
senden. Um die Freischaltung zu beenden, reicht eine SMS mit dem Text ABMELD an dieselbe Adresse. 

3.3.1.2 SMS über AnnyWay empfangen 
Um SMS über diesen Anbieter empfangen zu können, müssen Sie zuvor von diesem Anschluss aus eine SMS 
versandt haben; dadurch wird der betreffende Anschluss für den Empfang von Text-SMS freigeschaltet. Sollte 
der Empfang von AnnyWay deaktiviert worden sein, so lässt er sich mit einer SMS an 2547 (Text: CLIP) wieder 
aktivieren. 
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3.3.2 SMS im Festnetz – im Detail 

Um SMS im Festnetz nutzen zu können, sind diese Voraussetzungen notwendig: 

1. Die Übermittlung der eigenen Rufnummer bei  
Tixi Message Modem 

(Telekom-Festnetz) 

SMSC Anny Way 
(09003266900) 

SMSC DT AG 
(0193010) 

SMS-Empfänger 
(Telekom-Festnetz) 

ausgehenden Rufen muss aktiviert sein.  
(Telekom-Dienstmerkmal CLIR fallweise 
aktiviert.) 

2. Die Anzeige der Rufnummer eingehender Rufe 
muss aktiviert sein.  
(Telekom-Dienstmerkmal CLIP aktiviert.) 

3. Der Festnetz-Anschluss muss am SMSC2 als  
SMS-tauglich angemeldet sein. 

4. Das Endgerät muss SMS-tauglich sein. 

5. Der Telefonanbieter muss das Feature "SMS  
im Festnetz" anbieten. 

Nachrichten können über beide SMSC versandt werden. Damit SMS in jedem Fall in Textform empfangen 
werden können, empfiehlt es sich, im Gerät beide SMSC für den Empfang zu konfigurieren. 

 

 

Tixi Message Modem AT
(Telekom-Festnetz) 

SMSC D1 
SMSC lt. SIM-Karte 

SMSC D2 
SMSC lt. SIM-Karte 

SMSC E-Plus 
SMSC lt. SIM-Karte 

T-Mobile  
Teilnehmer 

(0171-xxxxxxx) 

Vodafone  
Teilnehmer 

(0172-xxxxxxx) 

E-Plus 
Teilnehmer 

(0177-xxxxxxx) 

SMSC-Festnetz 
Deutsche Telekom 

SMSC-Festnetz 
AnnyWay 

Empfang von SMS  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SMS aus dem D1-Netz werden im Festnetz über das SMSC der Deutschen Telekom AG empfangen, während 
Nachrichten aus dem D2- und O2-Netz über das SMSC des Anbieters Anny Way empfangen werden. 

                                                      
2 SMSC:  SMS Service Center 
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4 Tixi Message-Modus 
Bevor eine Nachricht mit den Tixi-Message-Befehlen verschickt werden kann,  
muss zuerst der Tixi Message Mode aktiviert sein. Siehe dazu Kapitel 2.5 (AT+T Mode="MessageMode"). 

4.1 Ablauf beim Senden einer Nachricht 
Der grundlegende Aufbau des Sendebefehls ist stets gleich -  
unabhängig davon, welchen Nachrichtentyp oder welches Tixi-Modem Sie benutzen: 

AT+T Send = "Nachrichtentyp; Parameter" 

Folgende Nachrichtentypen sind z.Z. möglich: 

SMS SMS senden 
Fax Text als Fax senden 
Express Express E-Mail senden 
EMail Internet E-Mail senden 
POP3 Internet E-Mail abholen 

Die Parameter enthalten die jeweils notwendigen Angaben, wie die Adressen von Absender und ggf. 
Empfänger, Internet-Zugangsdaten oder die Rufnummer des SMS-Service-Centers.  

Der Befehl zum Versand einer SMS könnte etwa so aussehen: 

AT+T Send = "SMS; To: 017312345678; ServiceCentreNumber: 0193010" 

Nach der Eingabe des Sendebefehls wird vom Tixi-Modem ein Prompt (>) zurückgeschickt, hinter dem Sie den 
Text der Nachricht eingeben können. Bei einer SMS wären dies 160 Zeichen in einer Zeile fortlaufend.  
Zum Absenden beginnen Sie eine neue Zeile (benutzen Sie dazu die ENTER-Taste) und drücken Sie dann die 
Tasten <STRG>+<Z> als Kennzeichen für das Ende der Eingabe des Textes. 

4.2 Informationen zu Tixi AT Kommandos 
Die speziellen AT-Kommandos für den Message-Modus können genauso wie die "normalen" AT-Kommandos 
des Hayes-Befehlssatzes verwendet werden. Für jedes dieser Kommandos lassen sich die bereits 
konfigurierten Werte sowie eine Liste der möglichen Parameter anzeigen; die Syntax ist bei jedem Kommando 
gleich. 

4.2.1 Konfigurierte Werte ausgeben "?" 

Um rasch einen Überblick zu erhalten, welche der Parameter bereits mit Werten "gefüllt" sind, senden Sie das 
Kommando, gefolgt von einem Fragezeichen.  
Kommando, um z.B. die bereits konfigurierten Parameter des Send Kommandos auszugeben: 

AT+T Send? 

4.2.2 Liste der Parameter ausgeben: "=?" 

Wenn Sie sich nicht sicher sind, welche Parameter für ein bestimmtes Kommando angegeben werden müssen, 
oder wie deren Syntax lautet, hilft Ihnen der Parameter-Abfragebefehl.  
Senden Sie das jeweilige Kommando, gefolgt von "=?". 
Kommando, um z.B. die möglichen Parameter des Send Kommandos auszugeben: 

AT+T Send=? 

Gibt eine Liste aller Parameter aus, die für das "SEND"-Kommando gelten.  
So können Sie jederzeit überprüfen, ob Sie die Werte vollständig angegeben haben, und welche noch fehlen. 
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4.3 Rückmeldungen beim Versand von Nachrichten 

4.3.1 Meldung nach jedem Versand einer Nachricht 

Nachdem ein Sendebefehl an das Tixi-Modem geschickt wurde, wird - nach Abschluß des Versandes - eine 
Meldung generiert, die die wichtigsten Angaben zum Sendevorgang enthält. 

Falls Sie den Schalter  Verbose="Off"  gesetzt haben, werden nur Kurzmeldungen ausgegeben  
(OK oder Error ).  
Bei  Verbose="On" enthalten die Rückmeldungen ausführliche Angaben zum Nachrichtenversand. 

Diese Meldungen haben grundsätzlich folgendes Format: 

+T Send: sending message 
* StartTime:  Beginn  Zeitpunkt des Starts der Übertragung 
* EndTime:    Ende Zeitpunkt, des Endes der Übertragung 
* Connect:    Speed Connect-Meldung des Modems 
OK OK-Antwort des Modems 

Je nach Nachrichtentyp werden weitere Informationen angegeben. 

Die ausführlichen Rückmeldungen sind wichtig, um Verbindungen zu testen und im Fehlerfall die Ursache 
schnell finden zu könnten. 

4.3.2 Express-E-Mail 

Zusatzinformation nach dem Versand einer Express E-Mail: 

* RemoteBoxName:   BoxName Name der Tixi-Mail Box beim Empfänger 
* RemoteBoxNumber: Nummer Rufnummer der Tixi-Mail Box beim Empfänger 
* RemoteBoxSerial: Serien# Seriennummer der Tixi-Mail Box beim Empfänger 

4.3.3 Fax 

Zusatzinformation nach dem Versand einer Faxnachricht: 

* FaxIdentify:    ID Stations-ID des empfangenden Faxgerätes 
* Pages:          Seiten Zahl der übertragenen Seiten 
* Baudrate:       Speed Geschwindigkeit der Übertragung 

4.3.4 SMS 

Zusatzinformation nach dem Versand einer SMS: 

* SMSC-Time:      Zeit Der Zeitstempel des Service-Centers 
über das die SMS versandt wurde. 

4.3.5 Versand von Internet E-Mail 

Nach dem Versand einer Internet E-Mail erhalten Sie keine zusätzlichen Informationen.  

4.3.6 Abholung von Internet E-Mail 

Zusatzinformation nach der Abholung von Internet E-Mail (POP3): 

* DetectedMails:   Zahl1 Anzahl der in der Mailbox erkannten Nachrichten 
* DetectedSize:    Grösse1 Größe der erkannten Nachrichten 
* ReceivedMails:   Zahl2 Anzahl der abgeholten Nachrichten 
* ReceivedSize:    Grösse2 Größe der abgeholten Nachrichten 

5 Tixi Message Befehle 
Diese erweiterten Befehle können Sie im Message Mode an das Tixi AT Modem senden. 
(Im Modem Mode führen diese Befehle zu einem Error.) 
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5.1 Übersicht der Befehle 
 Senden von Nachrichten 

AT+T Send="All; ..." setzt allgemeine Sendeparameter 
AT+T Send="SMS; ..." sendet eine SMS (je nach Gerät) 
AT+T Send="Fax; ..." sendet ein Fax (je nach Gerät) 
AT+T Send="EMail; ..." sendet eine Internet E-Mail 
AT+T Send="POP3; ..." holt Internet E-Mail vom Provider ab 
AT+T Send="Express; ..." sendet eine Express E-Mail 

 Steuerung und Konfiguration 
AT+T Send? gibt die aktuelle Konfiguration aus 
AT+T List gibt eine Liste der empfangenen Nachrichten aus 
AT+T Read gibt empfangene Nachrichten aus 
AT+T Delete löscht empfangene Nachrichten 
AT+T Time setzt die Systemzeit 

Time?  gibt die Systemzeit aus 
AT+T Echo schaltet das lokale Echo ein oder aus 
AT+T Verbose schaltet ausführliche Rückmeldungen ein oder aus 
AT+T MSN setzt die MSN von ISDN-Geräten 
AT+T Speaker setzt die Lautstärke des Modemlautsprechers 
AT+T Answer schaltet die Anrufannahme ein oder aus 
AT+T Erase setzt das Tixi AT Modem zurück (Factory defaults) 
AT+T Redial setzt die Anzahl der Wahlwiederholungen (default=0) 
AT+T RedialDelay legt die Pause zwischen zwei Wahlversuchen fest (default=90) 
AT+T DialRules legt das Wahlverfahren und Wähltonverhalten fest 
AT+T Mode schaltet zwischen Modem Mode und Message Mode um 
AT+T Help gibt eine Übersicht der erweiterten Befehle aus 
AT+T Format wählt das Datenformat auf der seriellen Schnittstelle 
AT+T Send="TransMode; ." Ferneinwahl in Tixi-Modem und Transparent Mode durch die RS 232 

auf die angeschlossene Steuerung s. Kapitel 6
 

 

Erläuterung der AT+T-Befehle auf den folgenden Seiten: 

AT+T Send = "All;..." Befehl in Kurzform 

AT+T Send = "ALL; ...." Syntax des Befehles mit allen Parametern 

Text Beschreibung des Befehls 

 Parameter mit Erläuterung 

 Beispiel 
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5.2 AT+T Send – SMS, E-Mail, Fax, Express E-Mail senden 

5.2.1 Allgemeine Tixi-Modem-Parameter setzen 

AT+T Send="All;..." 

AT+T Send="ALL; DialPrefix:nnn; ModemName:Name; ModemNumber:Nummer End:char" 

Dieser Befehl setzt die Parameter, die allen Nachrichtentypen gemeinsam sind;  
eine Nachricht wird dabei nicht versandt.  
Nach diesem Kommando kann kein Nachrichtentext eingegeben werden! 

nnn: Amtsholung 
 Falls das Tixi AT Modem an eine Telefonanlage angeschlossen ist und diese eine Vorwahl 

für die Amtsleitung erfordert, so soll diese hier angegeben werden.  
Es dürfen nur "wählbare" Zeichen (0-9, *, #, Komma) benutzt werden.  
Wenn keine Amtsholung benötigt wird, kann dieser Parameter entfallen. 

Name: Beim Senden von Faxnachrichten wird dieser Name in der Kopfzeile des versandten  
Faxes und als Tixi-Box-Name für den Versand von Express E-Mail verwendet.  
Es sind maximal 16 alphanumerische Zeichen erlaubt. 

Nummer: Nummer des Telefonanschlusses, mit dem das Tixi-Modem verbunden ist.  
Sie muss in dieser Form angegeben werden: 00493012345678.  
Diese Nummer wird in Kopfzeilen von Faxnachrichten und als Absender für Express E-Mail 
verwendet. 

Char: Definiert das Zeichen, welches die Nachrichteneingabe abschließt. Standard: 
<STRG>+<Z> 

Beispiel: 
Setzt die Amtsvorwahl "0", den Tixi-Modem-Namen "Tixi.Com GmbH" und  
die Telefonnummer "0049301345678": 

AT+T Send = "All; DialPrefix:0; ModemName: Tixi.Com GmbH; 
ModemNumber: 00493012345678" 

5.2.2 Ein Fax senden 

AT+T Send="Fax;..." 

AT+T Send="Fax; Dial: Nummer" 
>SubjectText 
>MessageText Zeile#1 
>MessageText Zeile#n 
><STRG>+<Z> 

Dieser Befehl sendet eine Textnachricht als Fax oder speichert diese Parameter.  
Nach dem Abschluss der Kommandozeile durch <CR/LF> sendet das Tixi AT Modem ein Prompt-Zeichen (>), 
hinter dem die Betreff-Zeile angegeben werden kann. In den darauf folgenden Zeilen wird der Nachrichtentext 
eingegeben. Um diesen abzuschließen, drücken Sie die Tasten <STRG>+<Z>. 

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert. 

Nummer: Rufnummer des Empfänger-Faxgerätes.  
Es dürfen nur "wählbare" Zeichen (0-9,*,#,Komma) benutzt werden. 

SubjectText: Erste Zeile des Nachrichtentextes. Sie bildet die Betreffzeile der Faxnachricht. 

MessageText Zeile#1...n:   Weitere Zeilen des Nachrichtentextes.  
Jede Zeile wird nach dem durch das Modem gesendeten Prompt-Zeichen eingegeben und 
durch <CR/LF> abgeschlossen. 

 Beim Versenden werden Zeilen über 75 Zeichen automatisch umgebrochen. Umlaute sind 
nicht erlaubt. 
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Beispiel: 
AT+T Send="Fax; Dial: 40578747" 
>Hallo Paul 
>Das ist die wichtige Nachricht als Fax. 
> 
>Bis bald. 
><STRG>+<Z> 

Kurze Modemantwort:    OK 

5.2.3 SMS senden 

AT+T Send="SMS;..." 

AT+T Send="SMS; To: Empfänger; ServiceCentreNumber: SCNummer; Type: Protokoll" 
>MessageText 
><STRG>+<Z> 

Dieser Befehl sendet eine SMS.  

Nach dem Abschluss der Kommandozeile durch <ENTER> (<CR/LF>) sendet das Tixi-Modem ein Prompt-
Zeichen (>), hinter dem der Nachrichtentext einzeilig, fortlaufend angegeben wird.  
Zum Beenden und Senden drücken Sie <ENTER> und dann die Tasten <STRG>+<Z>.  

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert. 

SCNummer: Nummer des jeweiligen SMS Service Centers.  
Dieser Parameter muss auch zum Empfang von SMS gesetzt sein, da über diese Nummer 
die Erkennung eingehender SMS-Anrufe erfolgt.  
Es dürfen nur "wählbare" Zeichen (0-9, Komma) benutzt werden. 

Empfänger: Nummer des Empfängers der SMS – zumeist eine Handynummer. 

Protokoll: Protokoll des jeweiligen SMS-Service Centers. Gültige Werte sind: 
D1_TAP SMS über D1-SMSC senden (an D1-Handy) 
Mobilkom_A_TAP SMS über Mobilkom-Austria-SMSC senden 

 D2_UCP SMS über D2-SMSC senden (an D2-Handy) 
PSTN SMS über Festnetz-SMSC senden 
 (z.B: an Festnetz-Geräte oder Handies) 

Wenn nichts angegeben ist, wird automatisch dasjenige Protokoll verwendet,  
das vom Host der Empfänger-Rufnummer unterstützt wird (nur in Deutschland). 

MessageText: Nach dem Prompt wird der SMS-Text eingegeben und durch <CR/LF> abgeschlossen.  
Für den Text einer SMS dürfen – einschliesslich des <CR/LF> - maximal 160 Zeichen 
verwendet werden. Umlaute sind nicht erlaubt. Der SMS-Text ist als fortlaufender, 
einzeiliger Text einzugeben. 

 (Das <CR/LF> Zeichen wird durch das Drücken der ENTER Taste erzeugt.) 

Beispiel: 

a)  Eine SMS wird gesendet, wobei der Sende-Befehl alle notwendigen Parameter konfiguriert: 

AT+T Send="SMS; To:071365776; ServiceCentreNumber:0193010" 
>Hier folgt der Text der Nachricht. 
><STRG>+<Z> 

    Ausführliche Modemantwort: 

+T Send: sending message 
* StartTime: 2001/10/30,09:42:13 
* EndTime: 2001/10/30,09:42:26 
* SMSC Time: 2001/10/30,09:42:48 
OK 
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b)  Eine SMS wird gesendet, wobei der Sende-Befehl die bereits konfigurierten Parameter (u.a. 
Empfängernummer) verwendet: 

AT+T Send="SMS;" 
> Hier folgt der Text der Nachricht. 
><STRG>+<Z> 

Kurze Modemantwort: 

OK 

Hinweis: Die Rufnummern der SMS-Service-Center finden Sie im Kapitel 3 dieses Handbuches. 

5.2.4 Express E-Mail versenden 

AT+T Send="Express;..." 

AT+T Send="Express; To: Empfänger; Dial: Nummer; From: Sender" 
>Subject 
>MessageText Zeile#1 
>MessageText Zeile#n 
><STRG>+<Z> 

Dieser Befehl sendet eine Express E-Mail.  
Nach dem Abschluss der Kommandozeile durch <CR/LF> sendet das Tixi AT Modem ein Prompt-Zeichen (>), 
hinter dem die Betreff-Zeile angegeben werden kann. In den darauf folgenden Zeilen wird der eigentliche 
Nachrichtentext eingegeben. Um diesen abzuschliessen, drücken Sie die Tasten <STRG>+<Z>. 

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert. 

Nummer: Dies ist die Nummer, die zum Anwählen des Empfängers (z.B. einer Tixi-Mail Box3 oder 
eines Tixi Super Modems gewählt werden muss.  
Geben Sie die Nummer exakt so an, wie sie gewählt werden muss - inklusive aller Landes- 
oder Ortsvorwahlen.  
Lassen Sie die Amtsvorwahl weg, die bei den allgemeinen Parametern angegeben wurde. 

Empfänger: Express E-Mail Adresse des Empfängers, z.B. PAUL+49-30-1234567.  
Diese wird in das To: Feld im Kopf der versandten Express E-Mail eingefügt. 

Sender: Express E-Mail Adresse des Absenders, z.B. OTTO+49-30-7654321.  
Diese wird in das From: Feld im Header der versandten Express E-Mail eingefügt. 

Subject: Betreffzeile der Nachricht.  
Diese wird immer aus der ersten Zeile generiert, die nach dem Prompt eingegeben wird. 

MessageText Zeile#n:    Weitere Zeilen des Nachrichtentextes.  
Jede Zeile wird nach dem vom Tixi-Modem gesendeten Prompt-Zeichen eingegeben und 
durch <CR/LF> abgeschlossen. 

 Beim Versenden werden Zeilen über 75 Zeichen automatisch umgebrochen. Umlaute sind 
nicht erlaubt. 

Beispiel: 

Eine Express-E-Mail wird gesendet, wobei der Sende-Befehl alle notwendigen Parameter konfiguriert: 

AT+T Send="Express; Dial: 1234567; From: OTTO+49-30-7654321; 
           To: PAUL+49-30-1234567" 
>Hallo Paul, 
>Der Lüfter in Raum 123 in Haus 12 ist ausgefallen. 
> 
>Gruss  Hans. 
><STRG>+<Z> 

Kurze Modemantwort: OK 

                                                      
3 Tixi-Mai Box: Ein Tixi-Modem mit 2 MB – 66 MB Speicher, das für einen PC als „E-Mail-Anrufbeantworter“ fungiert. 

Eine Tixi-Mail Box kann E-Mails empfangen und senden, auch wenn der PC ausgeschaltet ist. E-Mails 
werden in den üblichen E-Mail-Programmen, z.B. Outlook, bearbeitet (POP3 und SMTP). 
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5.2.5 Internet E-Mail senden (SMTP) 

AT+T Send="Email;..." 

AT+T Send="Email; To: Empfänger; Dial: Nummer; From: Sender; Flags:flag 
           PPPUser: User; PPPPassword: Password; SMTPMailServer: SMTPServer" 
>Subject 
>MessageText Zeile#1 
>MessageText Zeile#n 
><STRG>+<Z> 

Dieser Befehl sendet eine Internet E-Mail.  
Nach dem Abschluss der Kommandozeile durch <CR/LF> sendet das Tixi-Modem ein Prompt-Zeichen (>), 
hinter dem die Betreff-Zeile angegeben wird. In den folgenden Zeilen wird der eigentliche Nachrichtentext 
eingegeben. Um diesen abzuschliessen, drücken Sie die Tasten <STRG>+<Z>. 

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert. 

Nummer: Rufnummer des Internet-Providers. Es dürfen nur "wählbare" Zeichen (0-9,*,#,Komma) 
benutzt werden. 

Sender: Internet-E-Mail Adresse des Absenders der Nachricht, z.B.. paul@company.com.  
Diese Adresse wird für das From: Feld der ausgehenden Nachricht verwendet. 

Empfänger: Internet-E-Mail Adresse des Empfängers der Nachricht, z.B.. otto@provider.net. Diese 
Adresse wird für das To: Feld der ausgehenden Nachricht verwendet. 

flag Geben Sie hier "PbS" an, wenn POP-before-SMTP verwendet werden soll. 
(Ansonsten kann der Parameter entfallen.) 
 

User: PPP-Benutzername zur Einwahl in den Internet-Provider. 

Password: PPP-Passwort. 

SMTPServer: Name oder IP-Adresse des SMTP-Servers, der die Nachricht versenden soll, z.B. 
mail.provider.com. 

Subject: Betreffzeile der E-Mail. 
Diese wird immer aus der ersten Zeile generiert, die nach dem Prompt eingegeben wird. 

MessageText Zeile#1...n:   Weitere Zeilen des E-Mail-Textes.  
Jede Zeile wird nach dem vom Modem gesendeten Prompt-Zeichen eingegeben und durch 
<ENTER> abgeschlossen. Beim Versenden werden Zeilen über 75 Zeichen automatisch 
umgebrochen. Umlaute sind nicht erlaubt. 

Beispiel: Eine Internet E-Mail wird gesendet: 

AT+T Send="EMail; Dial: 0191011; From: RT343@T-Online.de; 
To: TaskForce@Tixi.Com; PPPUser: 00001234567844556677#0001; 
PPPPassword: Rose; SMTPMailServer: smtp.t-online.de" 

>Hallo Paul, 
>Das ist die wichtige Nachricht per E-Mail. 
><STRG>+<Z> 

Kurze Modemantwort: 

OK 
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5.2.6 Internet E-Mail abholen (POP3) 

AT+T Send="POP3;..." 

AT+T Send="POP3; Dial: Nummer; PPPUser: ISP-User; PPPPassword: ISP-PW; Flags:Flag;
           Username: Mailbox; Password: MailPW; POP3MailServer: POP3Server" 
>START 
><STRG>+<Z> 

Dieser Befehl prüft die angegebene E-Mailbox (POP3) und startet ggf. die Abholung von Internet E-Mail.  
Jede vollständig heruntergeladene Nachricht wird auf dem POP3 Server gelöscht. 

Wenn E-Mails in den Tixi-Speicher abgeholt wurden, leuchtet die rote Process/Mail-in LED am Tixi-Modem. 

Achtung! Da es sich um ein Send-Kommando handelt, erscheint auch hier ein Prompt,  
nachdem Sie den Befehl eingegeben haben.  
Drücken Sie ENTER und STRG+Z, dann wird die Mailabholung gestartet. Wenn Sie ESC 
drücken, werden die Einstellungen für spätere Mailabholungen gespeichert. 

Nummer: Rufnummer des Internet-Providers.  
Es dürfen nur "wählbare" Zeichen benutzt werden (0-9, *, #, Komma). 

ISP-User:  PPP-Benutzername zur Einwahl beim Internet-Provider.  
ISP-PW: PPP-Passwort.  
Flag: Wenn Sie "d" angeben, werden die Nachrichten nach der Abholung nicht vom Server 

gelöscht. 

Mailbox:  Benutzername der Mailbox (POP3) zur Anmeldung am Mail-Server.  
MailPW: Passwort der Mailbox.  
POP3Server: Hostname oder IP-Adresse des POP3-Mail-Servers, der die Nachricht vorhält, z.B. 

mail.provider.com.  

Beispiel:   Die Mailbox Meyer (Passwort: Else) auf dem Mail-Server mail.provider.com wird abgefragt. 
Zum PPP-Login wird der Benutzername Richard und das Passwort Tina benutzt: 

AT+T Send = "POP3; Dial: 2345678; PPPUser: Richard; PPPPassword: Tina; 
           Username: Meyer; Password: Else; 
           POP3MailServer: mail.provider.com" 
>START 
><STRG>+<Z> 
 

Modemantwort:    OK 
* DetectedMails:   Zahl1 Anzahl der in der Mailbox erkannten Nachrichten 
* DetectedSize:    Grösse1 Größe der erkannten Nachrichten 
* ReceivedMails:   Zahl2 Anzahl der abgeholten Nachrichten 
* ReceivedSize:    Grösse2 Größe der abgeholten Nachrichten 

 
Da die Konfigurationsparameter nur bei der erstmaligen Konfiguration notwendig und dann optional sind, kann 
die laufende Mailabholung auch mit dem folgenden Kurzkommando gestartet werden: 

AT+T Send = "POP3" 
><STRG>+<Z>   
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5.3 AT+T List - empfangene Nachrichten anzeigen 

AT+T List = "Typ" 

Gibt eine Liste aller empfangenen Nachrichten des angegebenen Nachrichtentyps zurück. 

Typ:  Der Typ der auszulesenden Nachrichten. Folgende Typen werden unterstützt: 
ALL Alle Nachrichten 
SMS SMS (mobil und Festnetz). 
Express Express E-Mail. 
EMail Internet E-Mail. 

Antwort: 
+Tlist=EintragNr#1, Typ#1, Zeit#1 
+Tlist=EintragNr#2, Typ#2, Zeit#2 
... 
+Tlist=EintragNr#n,Typ#n,Zeit#n 
OK 

EintragNr#n: Nummer des Eintrags. Mit dieser Nummer kann die betreffende Nachricht 
referenziert werden, um sie auszulesen oder zu löschen. 

Typ#n:  Nachrichtentyp des n-ten Eintrags in der Liste. 

Zeit#n: Zeitstempel der betreffenden Nachricht. Er wird vom Tixi AT Modem generiert, wenn 
die Nachricht vollständig empfangen wurde. 

Beispiel: 

AT+T List="ALL" Alle empfangenen Nachrichten anzeigen. 

Modemantwort: 

+T List=11,SMS,2001/10/7,12:05:55 
+T List=12,SMS,2001/10/7,12:10:16 
+T List=21,Express,2001/10/7,12:22:27 
OK 

 

AT+T List="SMS" Alle empfangenen SMS werden angezeigt. 

Modemantwort: 

+T List=11,SMS,2001/10/7,12:05:55 
+T List=12,SMS,2001/10/7,12:10:16 
OK 

5.4 AT+T Delete - eine gespeicherte Nachricht löschen 

AT+T Delete=Nummer.. 

Löscht die Nachricht mit der angegebenen Nummer aus dem Speicher des Tixi AT Modem. 

Nummer: Nummer der Nachricht, die gelöscht werden soll.  
Diese Nummer kann durch das List Kommando ermittelt werden. Um die erste 
gespeicherte Nachricht (also die älteste) zu löschen, geben Sie als Nummer eine 0 (Null) 
an. 

Beispiel: Eine Nachricht mit der Nummer 11 wird gelöscht: 

AT+T Delete=11 

Modemantwort:   OK 
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5.5 AT+T Read  - eine gespeicherte Nachricht auslesen 

AT+T Read=Nummer.. 

Liest die Nachricht mit der angegebenen ID aus dem Speicher des Tixi AT Modem aus.  
Die Nachricht wird dabei nicht gelöscht und kann beliebig oft ausgelesen werden. 

Nummer:  Nummer der Nachricht, die ausgelesen werden soll.  
Diese Nummer kann durch das List Kommando ermittelt werden.  
Um die erste gespeicherte Nachricht (das ist die älteste) auszulesen,  
geben Sie eine 0 (Null) an. 

 

Antwort: 

Kurze Antwort  (AT+T Verbose="Off"): 

+T Read= Nummer, Typ, Zeit  
*Nachricht 
OK 

ausführliche Antwort (AT+T Verbose="On"): 

+T Read: Nummer, Typ, Zeit 
"ParameterListe" 
*Nachricht 
OK  

Nachricht: Text der Nachricht.  
Jede Text-Zeile der gespeicherten Nachricht beginnt mit * 

ParameterListe: Zusätzliche Parameter – je nach Nachrichtentyp. 

Nummer:  Nummer der ausgelesenen Nachricht.  

Typ: SMS, Express E-Mail oder Internet Email 

Zeit: Zeitstempel der Nachricht,  
wird nach erfolgreichem Empfang vom Tixi AT Modem gesetzt. 

Beispiel:  Eine SMS mit der Nummer 11 wird ausgelesen: 

AT+T Read = 11 

Modemantwort: 

+T Read: 11, SMS, 2001/10/07,12:05:55 
"From:071346768422; TimeStamp:2001/10/07,12:05:37" 
*Das ist eine Nachricht von Hans ! 
OK 

5.6 AT+T Answer - das Antwortverhalten festlegen 

AT+T Answer="OnOff" 

Schaltet die Anrufannahme des Modems ein oder aus. Diese Einstellung ist für den Nachrichtenempfang 
ausschlaggebend. 

OnOff: 

On Anrufannahme ein (default) 

Off Anrufannahme aus 

Beispiel:    Die Anrufannahme ausschalten: 

AT+T Answer="Off" 

Modemantwort:  OK 
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AT+T Answer? 

Zeigt die aktuelle Einstellung an. 

Beispiel: 
AT+T Answer? 

Modemantwort: 

+T Answer: "On" 

OK 

 

5.7 AT+T Time - Systemzeit 

AT+T Time="Zeit" 

Setzt die Systemzeit des Tixi-Modems,  
die für interne Zeitstempel, Datums Felder für SMTP-Nachrichten und Fax-Kopfzeilen genutzt wird.  

Die interne Systemzeit muss bei allen Tixi-Modems gesetzt werden: 
- nach Erstanschluss 
- nach Zeitumstellungen (Normal-/Sommerzeit) 
- bei Einsatz in anderen Ländern/Zeitzonen 
- bei Geräten ohne Batterie-gepufferte RTC (Echtzeituhr)  

nach Trennung von der Stromversorgung/Stromausfall. 

Die Zeit sollte von der steuernden Anwendung nach Erfordernis überprüft und ggf. gesetzt werden. 

Zeit: Format der zu setzenden Systemzeit: 

JJJJ/MM/TT, hh:mm:ss, Zeitzone 

JJJJ: Jahr (1980....2036) 
MM: Monat (01...12) 
TT: Tag (01..31) 
hh: Stunde (00..23) 
mm: Minuten (00...59) 
ss: Sekunden (00...59) 
Zeitzone: Zeitzone, in der sich das Tixi-Modem befindet.  

Der Wert gibt die Differenz zur GMT an,  
mit dieser Syntax: +/-HHMM (z.B. +0100 für CET / MEZ). 

Beispiel:  Die Systemzeit des Tixi AT Modem wird auf den 24.1.2003, 12:16:00 CET gesetzt: 

AT+T Time="2003/01/24, 12:16:00, +0100" 

Modemantwort:   OK 

 

Die aktuelle Systemzeit auslesen: 

AT+T Time? 

Liest die Systemzeit des Tixi AT Modem aus. 

Beispiel: 
AT+T Time? 

Modemantwort: 

+T Time: 2003/1/24,12:17:00,+0100 
OK 



 Modem Handbuch    HSM AT V.90, HMM AT V.90 

 

 24/36  

5.8  AT+T Echo - das Echo ein- oder ausschalten 

AT+T Echo="OnOff" 

Schaltet das Echo für Tastatureingaben ein oder aus. 

OnOff: On   Echo eingeschaltet (default) 
Off   Echo ausgeschaltet 

Beispiel:    AT+T Echo="On" 

Modemantwort:   OK 

AT+T Echo? 

Zeigt die aktuelle Einstellung an. 

 

Beispiel: 
AT+T Echo? 

Modemantwort: 

+T Echo: "On" 

OK 

5.9 AT+T Verbose - ausführliche Antworten ein- oder ausschalten 

AT+T Verbose="OnOff" 

Schaltet die ausführlichen Antworten des Tixi-Modems ein oder aus. 

OnOff: On ausführliche Antworten einschalten (default) 

Off  ausführliche Antworten ausschalten 

Beispiel:     AT+T Verbose="On" 

Modemantwort:  OK 

AT+T Verbose? 

Zeigt die aktuelle Einstellung an. 

Beispiel: 
AT+T Verbose? 

Modemantwort: 

+T Verbose: "On" 

OK 
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5.10 AT+T Mode – ModemMode oder MessageMode einstellen 

AT+T Mode="Modus" 

Setzt den Betriebsmodus des Tixi-Modems. 

ModemMode:  Tixi-Modem arbeitet wie ein "normales" Modem bzw. ein ISDN-TA.  
Es gelten die Standard Hayes AT-Befehle. 
Die Tixi-Message Befehle gelten nicht. 
Die rote Modem Mode LED leuchtet.  

MessageMode:  Die automatischen Funktionen des Tixi AT Modems sind aktiviert und nutzbar.  
Dieser Modus muss eingeschaltet sein,  
sonst können die hier beschriebenen Message Kommandos nicht genutzt werden !! 
Die Standard Hayes AT-Befehle gelten nicht. 
Die Modem Mode LED ist ausgeschaltet.  

Weitere Modi für andere Tixi-Modem-Produkte:  TiXMLMode,  TixiMode (Modem Mode LED aus.) 

Modus:       ModemMode    (default) 
  MessageMode 

Beispiel:       AT+T Mode="MessageMode"            Schaltet den Message Mode ein. 
Modemantwort: OK (die Modem Mode LED geht aus) 
 

Nutzen Sie auch:  AT+T Mode?           zeigt den aktuellen Modus an 
und    AT+T Mode=?          zeigt die möglichen Modi an 

 

5.11 AT+T Help - eine Befehlsübersicht anzeigen 

AT+T Help 

Gibt eine Übersicht über den über den erweiterten Befehlssatz des Tixi Message-Modems.  
So können Sie bei der Arbeit mit dem Tixi-Modem jederzeit auf die wichtigsten Informationen zugreifen, auch 
wenn das Handbuch einmal nicht zur Stelle sein sollte. (Keine Parameter.)  

5.12 AT+T Erase  - das Tixi AT Modem zurücksetzen 

AT+T Erase 

Dieser Befehl setzt das Tixi-Modem zurück. Dabei wird das Modem neu gestartet, alle benutzerdefinierten 
Einstellungen werden gelöscht und das Gerät wird in den Auslieferungszustand (Factory defaults) versetzt. 

5.13 AT+T Redial –Wahlwiederholung  

AT+T Redial="Wiederholungen" 

Setzt die Zahl der automatischen Wahlwiederholungen. 

Wiederholungen   0...9   (default=0) 

Beispiel:    AT+T Redial="3" 

Modemantwort:  OK  

AT+T Redial? 

Zeigt die konfigurierte Zahl der automatischen Wahlwiederholungen an. (Keine Parameter) 

AT+T Redial? 

Modemantwort: 

+T Redial:"3" 
OK  
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5.14 AT+T RedialDelay –Verzögerung Wahlwiederholung  

AT+T RedialDelay="Pause" 

Legt die Wartezeit zwischen automatischen Wahlwiederholungen fest. 

Pause   60...600   (default=90) 

Beispiel:    AT+T RedialDelay="120" 

Modemantwort:  OK  

AT+T RedialDelay? 

Zeigt die Wartezeit zwischen automatischen Wahlwiederholungen an. (Keine Parameter) 

AT+T RedialDelay? 

Modemantwort: 

+T RedialDelay:"90" 
OK  

5.15 AT+T DialRules –Wahlverfahren, Wähltonverhalten 

AT+T DialRules="Wahlverfahren,Wähltonverhalten" 

Bestimmt das Wahlverfahren und die Erkennung des Wähltons. 

Wahlverfahren : 

  Tone:  Tonwahlverfahren (MFV) (default) 

  Pulse:  Impulswahlverfahren IWV 

Wähltonverhalten : 

  NoWaitForDialTone:  kein Warten auf den Wählton (ATX3) 

  WaitForDialTone :   Warten auf den Wähton (ATX4) 

Beispiel:    AT+T DialRules="Tone,NoWaitForDialTone" 

Modemantwort:  OK  

AT+T DialRules? 

Zeigt die Einstellung des Wahlverfahrens und des Wähltonverfahrens an. (Keine Parameter) 

AT+T DIalRules? 

Modemantwort: 
+T DialRules: "Tone,NoWaitForDialTone"  
OK  

5.16 AT+ T Speaker - den Lautsprecher einstellen 

AT+T Speaker="Volume" 

Stellt die Lautstärke des Modem-Lautsprechers ein.  
Dieser Befehl gilt nur für analoge Tixi-Modems (SM03, EM20) und für das EF20. 
Volume: 

Off schaltet den Lautsprecher aus 
Min geringe Lautstärke (default) 
Middle mittlere Lautstärke 
Max maximale Lautstärke 

Beispiel:   AT+T Speaker="Middle" 

Modemantwort:   OK 

AT+T Speaker? 
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Zeigt die aktuelle Einstellung an. 

Beispiel: 
AT+T Speaker? 

Modemantwort: 

+T Speaker: "Off" 

OK 
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5.17 AT+T Format –Datenformat 

AT+T Format="Datenformat " 

Schaltet das Datenformat auf der seriellen Schnittstelle um. 

Datenformat   DatenbitsParitätStopbits 

            Datenbits :  8 
                    7 

            Parität :    N (keine) 
                    E (gerade) 
                    O (ungerade) 

            Stopbit :   1 
                    2 

Beispiel:    AT+T Format="8E1" 

Modemantwort:  OK  

AT+T Format? 

Zeigt das derzeit aktive Datenformat an 

AT+T Format? 

Modemantwort: 
8E1  
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6 RS 232-Transparent-Modus (TransMode) 
Der TransMode ermöglicht es, eine Steuerung (SPS) oder ein anderes RS-232-Gerät über ein Tixi-Modem 
fernzusteuern – so als ob man neben den Gerät sitzt und lokal per RS 232 verbunden wäre.  
Sämtliche Befehle, die Sie diesem Gerät über die lokale RS 232-Schnittstelle geben können, lassen sich über 
den TransMode auch von jedem beliebigen Telefonanschluss oder per GSM-Modem erteilen. 

Die Einwahl kann durch ein Passwort geschützt werden. 

Eine Anwendung des TransMode-Befehles wäre zum Beispiel die Steuerung und Konfiguration einer 
technischer Anlage, die über eine RS 232-Schnittstelle mit dem Tixi Message Modem AT verbunden ist. 

Um den TransMode zu nutzen, gehen Sie so vor: 

1. Konfigurieren Sie das Tixi Message Modem AT mit dem TransMode Befehl.  

2. Schliessen Sie das Tixi-Modem an das Gerät an, das Sie fernsteuern möchten. 
Dazu benötigen Sie ein Null-Modemkabel (meist Stecker-Stecker), z.B. den "Blue Adapter". 

3. Testen Sie die Ferneinwahl mit einem Tixi-Modem oder einem anderen Modem mit Hilfe eines  
Terminalprogrammes (Anwahl des Tixi Message Modems). 

4. Innerhalb von 5 Sekunden nach dem CONNECT des Modems  
muss das Login-Kommando an das angewählte Tixi Message Modem gesendet werden. S. Kap. 6.2. 
Dann wird die RS 232 über die beiden Modems durchgeschaltet. 

5. Steuern Sie Ihr entferntes Gerät.  
Alle Daten, die Sie vom PC an das lokale Modem senden, werden über die Telefonleitung an das Tixi 
Message Modem AT und von diesem per RS 232 an das angeschlossene Gerät übertragen.  
Sie können es bedienen, als ob Sie direkt davor säßen.  

6. Abbau der Verbindung durch 
– Auflegen des anrufenden Modems 
– optionale Zeitbeschränkung (Timeout) im Tixi-Modem 
   wenn keine Daten mehr kommen. (Default 75 Sekunden.) 

 
Laufzeitverzögerungen bei Modemübertragungen 
Durch eine Fernverbindung und die Datenumwandlung in den beiden Modems entstehen Verzögerungen in der 
Laufzeit der Daten vom PC zu der Steuerung im Vergleich zu einer direkten lokalen Verbindung über ein RS 232 
Kabel. Manche Konfigurations-Programme für Steuerungen erwarten eine Antwort innerhalb von wenigen 
Millisekunden. Bei diesen Programmen können Fehler auftreten. Fragen Sie den Hersteller dieser Programme 
und Steuerungen, wie das Timeout für die Kommunikation mit der Steuerung erhöht werden kann, z.B. auf 500 
ms. 

6.1 TransMode Befehl 

AT+T SEND="TransMode; ..." 

AT+T SEND="TransMode; Enabled:enabled; Password: password; Format: format;  
Handshake:handshake; Keep:timeout; Baudrate: RS232Speed; Com:Port" 

Schaltet bei Einwahl von außen die RS 232 zu einem angeschlossenen Gerät durch,  
so dass das Gerät ferngesteuert werden kann.  

Enabled Schaltet den TransMode aktiv (On) oder inaktiv (Off). 
Password Zugangspasswort  

Es schützt Ihr Tixi Message Modem AT vor unbefugter Einwahl  
und damit die angeschlossene Steuerung vor Benutzung durch Unbefugte.  
Wenn kein Passwort angegeben ist (Default: leer) und AT+T Answer="On", 
kann sich jeder einwählen. 

format Datenformat der RS232-Schnittstelle. 
Notation:   DatabitsParityStopbits. Default: 8N1. 

handshake Handshake-Protokoll der RS 232.  
Werte: None, RTSCTS, XONXOFF, SUCOM 
SUCOM gilt für die Moeller EASY 400, 600 und 800 Klein-SPS. 
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timeout Idle-Timeout - Legt fest, wie lange die Verbindung bestehen bleibt, nachdem keine Daten 
mehr übertragen werden. Der Defaultwert ist 75 Sekunden. 
Ein Wert von 0 schaltet diese Funktion ab, d.h. das Tixi-Modem wird die Verbindung nicht 
beenden, auch wenn keine Daten mehr kommen 

RS232Speed Datengeschwindigkeit auf der RS 232 zwischen dem Tixi Message Modem AT und dem 
daran angeschlossenen Gerät.  
Default-Wert: 115.200 Baud. 

Port Remote-Schnittstelle, auf die durchgeschaltet werden soll. 

Beispiel:  Das Tixi AT Modem wird für den TransMode konfiguriert: 

AT+T SEND="TransMode; Password:sesam; Format:8N1; Handshake:None; Keep:20; 
Baudrate:9600; Enabled:On; Com:MB" 

Bei Eingang eines Anrufes schaltet das Tixi-Modem die RS 232 zum angeschlossenen Gerät durch. 
Alle Daten werden nun in beide Richtungen so über tragen, als ob die Geräte direkt verbunden wären. 

6.2 Login-Kommando für den TransMode 
Um den TransMode des Tixi Message Modem AT zu nutzen, müssen diese Voraussetzungen erfüllt sein: 

1. Das Tixi Message Modem AT muss mit einem durchwahlfähigen Telefonanschluss verbunden sein,  
das heisst, Sie müssen es anrufen können. (Probieren Sie das zuerst mit einem Telefon aus.) 

2. Die Anrufannahme des Tixi-Modems muss aktiviert sein (AT+T Answer="On"). 

3. Das Tixi Message Modem AT muss zuvor mittels des TransMode-Befehls konfiguriert worden sein. 

Um sich über eine Modem-Wählverbindung und das Tixi Message Modem AT mit der an diesem 
angeschlossenen Peripherie zu verbinden, müssen Sie sich zunächst in das Tixi Message Modem AT 
einwählen.  
Benutzen Sie dafür ein Tixi-Modem oder jedes andere Modem. 

Senden Sie spätestens fünf Sekunden nach dem CONNECT das Login-Kommando für den Transmode-
Befehl.  

 
Für das Login-Kommando gibt es zwei Möglichkeiten: 
a)  Login ohne Parameter 

[password]        Login mit Passwort 

[]               Login ohne Passwort 

 

b) Login mit Passwort und mit Parametern 
[password; Format:format; Handshake:handshake; Keep:timeout; Baudrate: RS232Speed] 

(Parameterbeschreibung siehe Abschnitt 6.1) 
 
Die Konfiguration des Message Modems sollte i.A. lokal erfolgen, getestet werden und erst dann für die  
Ferneinwahl freigegeben werden.  
Das Fernändern der Parameter überschreibt die zuvor konfigurierten – und getesteten - Parameter. 
Das Fernändern der Parameter sollte nur genutzt werden, wenn es unbedingt nötig ist. 
Es kann auch immer verwendet werden, um eventuelle lokale Änderungen auszuschließen. 
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7 TACO - Die Tixi AT-Console 

7.1 Schnellstart 
Die Tixi AT-Console ermöglicht Ihnen einen schnellen Einstieg in Konfiguration und Testbetrieb des Tixi 
Message Modems und des Tixi Super Modems. Sie können hier alle notwendigen Parameter schnell erlernen, 
einfach einstellen, diese Einstellungen auf der Festplatte speichern und sie ins Tixi-Modem übertragen. 

Dabei brauchen Sie sich um die Syntax der Befehle nicht zu kümmern, da die Konsole diese automatisch 
generiert. Sie müssen lediglich die Rufnummern, Nachrichtentexte u.a. Daten eingeben. 

Um einen Eindruck von der Tixi AT-Console zu gewinnen, folgen Sie dieser Anleitung, um ein Testfax aus dem 
Tixi AT Modem zu versenden.  

1. Schliessen Sie das Tixi AT Modem an. 

2. Installieren Sie die Tixi AT-Console TACO. 

3.  Starten Sie TACO.  
Falls eine Fehlermeldung No response from modem erscheint, ist das Tixi AT Modem nicht an COM2 
angeschlossen. Wählen Sie im Menü [Options] > [RS232 Setup] aus, an welchen COM-Port Ihres PCs das 
Tixi AT Modem angeschlossen ist. 

4. Wechseln Sie auf die Registerkarte [ALL]. Tragen Sie dort unter [DialPrefix] eine ggf. benötigte 
Amtsvorwahl ein; sonst lassen Sie das Feld leer. Geben Sie unter [ModemName] Ihre Station-ID an und 
unter [ModemNumber] die Rufnummer des verwendeten Anschlusses.  
Klicken Sie auf den [Send] Button der Registerkarte [ALL], um diese Angaben im Tixi-Modem zu speichern. 

5. Wechseln Sie auf die Registerkarte [Fax].  
Tragen Sie unter [Dial] die Rufnummer des Empfängers ein (ggf. mit Ortskennzahl). 

6. Geben Sie in der rechten Hälfte des Fensters in den Feldern [Subject] und [Message] einen Betreff und die 
Nachricht ein. Klicken Sie auf den [Send] Button der [Fax] Registerkarte. 

7. Der Befehl wird in das Tixi-Modem übertragen und sofort ausgeführt. 

7.2 Benutzeroberfläche 
Die Oberfläche der Tixi AT-Console gliedert sich in zwei Teile: Links finden Sie Registerkarten für jeden 
Nachrichtentyp, auf denen die jeweils notwendigen Sendeparameter angegeben werden können. Rechts 
können Sie den Betreff und Text Ihrer Nachricht eingeben. Auch das Log-Fenster mit den Antworten und Status-
Informationen des Tixi AT Modem finden Sie hier. 

7.2.1 Log-Fenster 

Hier werden alle Rückmeldungen des Tixi AT Modem angezeigt. Benutzen Sie den Schalter [verbose reports] 
auf der Registerkarte Misc, um ausführliche Meldungen zu erhalten. Mit dem Button [Clear] können Sie den 
Inhalt des Fensters jederzeit löschen. 

7.2.2 Menüleiste 

Hier finden Sie einige weitere Optionen: 

File > Save As -        speichert die aktuelle Konfiguration auf der Festplatte 

File > Load From -       lädt eine zuvor gespeicherte Konfiguration von der Festplatte 

File > Exit      beendet das Programm 

Options > RS232 Setup -       konfiguriert die serielle Schnittstelle 

Options > Load Parameters from Modem  liest alle Parameter aus dem Tixi AT Modem aus 

Options > Store Parameters to Modem    überträgt alle Parameter ins Tixi AT Modem 

Command -       Eingabefeld für beliebige Kommandos an das Tixi-Modem 

Help -       Fenster mit Angaben zur Versionsnummer u.ä. 
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7.2.3 Registerkarten mit den Sendeparametern 

In den Eingabefeldern auf den Registerkarten finden Sie die Parameter wieder, die für das Kommando Send im 
Kapitel 5.2 dieses Handbuches beschrieben werden. Der Button [Send] rechts unten überträgt die angegebenen 
Parameter der aktuellen Registerkarte ins Tixi AT Modem. 

Wenn auf der rechten Seite weder ein Betreff noch ein Text für die Nachricht angegeben ist, werden nur die 
Parameter gesetzt; andernfalls wird mit den jeweiligen Parametern eine Nachricht generiert und versandt. Auf 
der Registerkarte Get finden sich alle Funktionen zur Verarbeitung empfangener Nachrichten. 

Hier ist ein kurzer Überblick über die Registerkarten und die darauf anzugebenden Parameter: 

ALL - allgemeine Parameter für alle oder mehrere Nachrichtentypen 
DialPrefix -  Amtsvorwahl 
ModemName -  Modemname für Express E-Mail und für  

Kopfzeilen ausgehender Faxnachrichten 
ModemNumber -  Rufnummer des verwendeten Anschlusses 

SMS - Parameter für den Versand von SMS 
ServiceCentreNumber -  Rufnummer des SMS-Servicecenters 
To -  Rufnummer des Empfängers 

Express - Parameter für den Versand von Express-E-Mail 
Dial -  Rufnummer der Gegenstelle – ggf. mit Ortsvorwahl mit führender Null. 
To -  Express-E-Mail Adresse des Empfängers 
From -  Express-E-Mail Adresse des Absenders 

Fax - Parameter für den Versand von Faxnachrichten 
Dial -  Rufnummer der Gegenstelle – ggf. mit Ortsvorwahl mit führender Null. 

EMail - Parameter für den Versand von Internet-E-Mail 
Dial -  Rufnummer des ISP-Einwahlknotens 
To -  E-Mail Adresse des Empfängers 
From -  E-Mail Adresse des Absenders 
PPPUser -  Benutzername zum PPP-Login beim Provider 
PPPPassword -  Kennwort zum PPP-Login beim Provider 
SMTPMailserver -  Mailserver für ausgehende Nachrichten 
PbS aktiviert POP-before-SMTP zum Nachrichtenversand 

Get - empfangene Nachrichten im Log-Fenster anzeigen 
Get Message List -  Listet empfangene Nachrichten mit ihren ID-Nummern auf 
Message ... -  ID-Nummer der Nachricht, auf die sich eine der folgenden Aktionen bezieht: 
Read Message -  liest die unter [Message] angegebene Nachricht aus und zeigt sie an 
Delete Message -  löscht die unter [Message] angegebene Nachricht 

Misc - sonstige Parameter 
verbose reports -  aktiviert die Ausgabe ausführlicher Rückmeldungen 
Get Time -  liest die Systemzeit des Gerätes aus und zeigt sie im Log-Fenster an 
Set Time -  Dialog zum Setzen der Systemzeit im Tixi-Modem 

TransMode - Parameter für den TransMode 

Com Gibt den COM-Port an, auf den die Verbindung durchgeschaltet wird. Beim Tixi 
Message Modem ist dies immer MB (Mainboard). 

Baudrate Legt die zwischen Tixi Message Modem und angeschlossener Steuerung 
verwendete Baudrate fest. 

DataBitsParityStopBits Das verwendete Datenformat. Default ist 8N1. 
Handshake Das verwendete Handshake-Protokoll zwischen Tixi und SPS. 
Keep Leerlaufzeit, nach der die Verbindung getrennt wird. Geben Sie "0" ein, damit 

nicht automatisch getrennt wird. 
Password Geben Sie hier das Passwort ein, dass bei der Einwahl angegeben werden 

muss, um unautorisierten Zugriff zu verhindern. 
Enabled Aktivieren Sie dies, um den TransMode einzuschalten. Andernfalls werden nur die Parameter gesetzt. 



 Modem Handbuch    HSM AT V.90, HMM AT V.90 

 

 33/36  

8 Technische Daten  

8.1 Hauptfunktionen 
Fax Meldungen als Fax (Text) versenden 

SMS Senden und Empfangen von SMS 

E-Mail Senden und Empfangen von E-Mail (SMTP/POP3) 

Express-E-Mail E-Mail über direkte Telefonverbindung senden und empfangen. Sichere E-Mail-
Übertragung ohne Internet mit sofortiger Zustellung an den Empfänger. 

Fernsteuerung Fernbedienung und -wartung einer SPS über das Telefonnetz 

 

8.2 Systemarchitektur 
CPU 32 Bit RISC-Prozessor 

Programmspeicher max 1 MB Flash-ROM 

Datenspeicher 30 kB SRAM bei HSM, 2 MB bei HMM 

 

8.3 Telefonnetz 
Netz Analoger Telefonanschluss (a/b Interface), RJ11  

Datenübertragung 300bps - 56kbps  
ITU-T (V.90, V.34+, V.32bis, V.32, V.22bis, V.22, V.21), Bell 212A, 
Bell103 

Faxübertragung Fax Gruppe 3 / Class 1 
2400bps - 14,4kbps, ITU-T (V.17, V.29, V.27ter, V.21 ch2) 

Fehlerkorrektur/ 
Datenkompression V.42 / MNP 2-4, V.42bis / MNP5 

 

8.4 Firmware 
Betriebssystem Kommerzielles RTOS (real-time multitasking operating system) mit C++ 

Abstraction Layer 

File-System Kommerzielles DOS-kompatibles Flash-File-System mit C++ Abstraction Layer 

 

8.5 Serielle Schnittstelle 
COM1 (RS232) ITU-T V.24, V.28, Hardware-Handshake 

D-Sub 9-polig, Buchse 
FIFO 16550, max. 230.400 bps 
Signale: DTR, DSR, RTS, CTS, DCD, GND, RI, RxD, TxD 
Übertragungsdistanz: 12 m 
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8.6 Allgemeine Daten 
Spannungsversorgung 10...30 VDC, max  0,7A, Schraubklemmen 2,5 mm2

LED-Anzeige Power, Mail in, Line, Mail out, Modem Mode 

Bedienelemente Service-Button 

Gehäuse/Montage DIN-Schienen-Gehäuse, auf Hutschiene 35mm nach EN50022, 
senkrecht oder waagerecht 

Konformität  

EMV: 
EN55022 (9:2003), EN55024 (10:2003) 

Safety: EN60950 

Telecom: 
R&TTE-Richtlinie TS 103021 

Temperaturbereich Betrieb: 0...+50°C, Lagerung: -30...+70°C 

Zulässige Luftfeuchte 5...95% relative Feuchte, nicht betauend 

Schutzart IP20 

Verschmutzungsgrad Verschmutzungsgrad 2 

Abmessungen Breite 88mm x Höhe 57mm x Tiefe 91mm 

Gewicht 180 g 

 

8.7 Abmessungen 
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8.8 LEDs, Reset, Update, Fehlerdiagnose  
LEDs beim Neustart  

Ein Neustart des Modems mit Speichertest läuft nach dem Einschalten der Stromversorgung, nach einem 
Factory Reset und nach dem Einspielen einer neuen Firmware ab.  

Power 
(gelb) 

Mail in 
(rot) 

Line 
(grün) 

Mail Out
(gelb) 

Modem 
Mode 
(rot) 

 

     Start Selbsttest 

     Test aller LEDs 

     Speichertest 

     Gerät ist betriebsbereit 

     Gesamtdauer: ca. 12 sec 

 

 

 

9 Garantie und technische Unterstützung 
Garantieleistungen 
Dieses Gerät wurde nach den modernsten Methoden hergestellt und geprüft. Der Hersteller übernimmt für zwei 
Jahre, gerechnet vom Tage des Verkaufs, Garantie zu den nachfolgenden Bedingungen: 
Innerhalb der Garantiezeit werden alle Mängel kostenlos beseitigt. Reklamationen sind unmittelbar nach 
Feststellung zu melden. Für Vollkaufleute besteht die Rügepflicht innerhalb von sieben Tagen. 

Der Hersteller behält sich vor, bei Reklamationen die defekten Teile auszubessern oder zu ersetzen oder das 
Gerät auszutauschen. Ausgetauschte Teile gehen in sein Eigentum über. Die Garantiezeit für ausgetauschte 
Teile endet mit der Garantiezeit für das gesamte Gerät. 

Der Hersteller ist berechtigt, im Rahmen der Garantieleistungen technische Änderungen (z.B. Firmware-
Updates) vorzunehmen, um das Gerät dem aktuellen technischen Stand anzupassen. Dem Erwerber entstehen 
hierdurch keine zusätzlichen Kosten. Ein Rechtsanspruch hierauf besteht nicht. 

Der Garantieanspruch erlischt bei Eingriffen durch den Käufer oder durch Dritte. Schäden, die durch 
unsachgemäße Behandlung oder Bedienung, durch falsches Aufstellen oder Aufbewahren, durch 
unsachgemäßen Anschluss oder Installation sowie durch höhere Gewalt oder sonstige äußere Einflüsse 
entstehen, fallen nicht unter die Garantieleistungen. Weist das Gerät mechanische Beschädigungen 
irgendwelcher Art auf, sind Garantieansprüche ausgeschlossen. 

Das Recht der Bundesrepublik Deutschland findet Anwendung. 

 

Technische Unterstützung 
Falls es im Betrieb des Tixi AT Modem einmal zu Problemen kommen sollte, setzen Sie sich bitte mit der 
technischen Hotline Ihres Fachhändlers in Verbindung. Übermitteln Sie dazu bitte diese Angaben: 

•  Fehlerbeschreibung. Der Fehler sollte reproduzierbar sein, damit er behoben werden kann.  

 Die Versionsnummer der Tixi AT Modem Firmware - diese erfahren Sie, wenn Sie im Modem Mode 
über ein Terminalprogramm den Befehl ATI1 an das Gerät senden. 

• Die Art Ihres Telefonanschlusses (Anbieter, freigeschaltete Dienstmerkmale, Telefonanlage) 

• Angaben über die Gegenstelle – (Typ: Faxgerät, Modem, Telefonanlage, Software etc.). 
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